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S&C Vista® SD Underground Distribution Switchgear
Outdoor Distribution (17.5 kV and 29 kV)

With Visi-Gap® 
Load-Interrupter Switches and 
Visi-Gap® Fault Interrupters



Qualified Persons
 WARNING

The equipment covered by this publication must be operated and maintained by qualified 
persons who understand any hazards involved and are thoroughly trained in the operation 
and maintenance of electronic control devices which are used in conjunction with power dis-
tribution equipment. These instructions are intended only for such qualified persons. They 
are not intended to be a substitute for adequate training and experience in safety proce-
dures for this type of equipment.

Read this 
Instruction Sheet NOTICE

Thoroughly and carefully read this instruction sheet before programming, operating,  
or maintaining your S&C Overcurrent Control. Familiarize yourself with the Safety Informa-
tion on page 3. The latest version of this instruction sheet is available online in PDF format 
at sandc.com/Support/Product-Literature.asp

Retain this 
Instruction Sheet

This instruction sheet is a permanent part of your S&C Vista SD Underground Distribu­
tion Switchgear. Designate a location where you can easily retrieve and refer to this 
publication.

Warranty The warranty and/or obligations described in S&C’s standard conditions of sale, as set 
forth in Price Sheet 150, plus any special warranty provisions, as set forth in the applicable 
product-line specification bulletin, are exclusive. The remedies provided in the former 
for breach of these warranties shall constitute the immediate purchaser’s or end user’s 
exclusive remedy and a fulfillment of all seller’s liability. In no event shall the seller’s 
liability to immediate purchaser or end user exceed the price of the specific product 
that gives rise to the immediate purchaser’s or end user’s claim. All other warranties, 
whether express or implied or arising by operation of law, course of dealing, usage of 
trade or otherwise, are excluded. The only warranties are those stated in Price Sheet 150, 
and THERE ARE NO EXPRESS OR IMPLIED WARRANTIES OF MERCHANTABILITY 
OR FITNESS FOR A PARTICULAR PURPOSE. ANY EXPRESS WARRANTY OR 
OTHER OBLIGATION PROVIDED IN PRICE SHEET 150 IS GRANTED ONLY TO THE 
IMMEDIATE PURCHASER AND END USER, AS DEFINED THEREIN. OTHER THAN AN 
END USER, NO REMOTE PURCHASER MAY RELY ON ANY AFFIRMATION OF FACT OR 
PROMISE THAT RELATES TO THE GOODS DESCRIBED HEREIN, ANY DESCRIPTION 
THAT RELATES TO THE GOODS, OR ANY REMEDIAL PROMISE INCLUDED IN PRICE 
SHEET 150.

Warranty 
Qualifications

The seller’s standard warranty does not apply to components not of S&C manufacture that 
are supplied and installed by the purchaser or to the ability of seller’s equipment to work 
with such components.

Introduction
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Understanding  
Safety-Alert 
Messages

Several types of safety-alert messages may appear throughout this instruction sheet and 
on labels attached to the S&C Overcurrent Control. Familiarize yourself with these types 
of messages and the importance of these various signal words:

 DANGER
“DANGER” identifies the most serious and immediate hazards that will likely  
result in serious personal injury or death if instructions, including recommended pre
cautions, are not followed.

 WARNING
“WARNING” identifies hazards or unsafe practices that can result in serious per-
sonal injury or death if instructions, including recommended precautions, are  
not followed.

 CAUTION
“CAUTION” identifies hazards or unsafe practices that can result in minor  
personal injury if instructions, including recommended precautions, are not followed.

NOTICE
“NOTICE” identifies important procedures or requirements that can result in product or 
property damage if instructions are not followed.

Following Safety  
Instructions

If you do not understand any portion of this instruction sheet and need assistance,  
contact your nearest S&C Sales Office or S&C Authorized Distributor. Their tele- 
phone numbers are listed on S&C’s website sandc.com. Or call the S&C Global Monitoring  
and Support Center at 1-888-456-1100.

NOTICE

Thoroughly and carefully read this  
instruction sheet before programming 
your S&C Overcurrent Control.

Replacement  
Instructions  
and Labels

If you need additional copies of this instruction sheet, contact your nearest S&C Sales 
Office, S&C Headquarters, or S&C Electric Canada Ltd.

It is important that any missing, damaged, or faded labels on the equipment be  
replaced immediately. Replacement labels are available by contacting your nearest S&C 
Sales Office, S&C Headquarters, or S&C Electric Canada Ltd.

Safety Information
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Location of Safety Labels

Enclosure for overcurrent control with cover removed to show electronics module.

Electronics module

 WARNING
Hazardous voltage inside can shock, burn, 
or cause death.

Safety Information

 DANGER

Never disconnect current transformer 
secondary circuits without de-energizing 
the switchgear. Hazardous voltage will 
shock, burn, or cause death.

Burden-board module

Electronics module removed to show burden-board module.
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Enclosure is mounted on switchgear 
(pad-mounted style shown here—a 
stainless steel enclosure is provided for 
vault-mounted style Vista SD)

Adapter cable connects overcurrent 
control to a personal computer

Personal computer is used to input 
settings and interrogate event recorder

General The following instructions are for field and shop programming of the S&C Overcurrent 
Control. This microprocessor-based control is designed for use on S&C Vista SD Under­
ground Distribution Switchgear to provide fault detection and operation of the resettable 
vacuum fault interrupters. Each overcurrent control operates up to two three-pole fault 
interrupters. The control is housed in an enclosure mounted to the operating mechanism 
enclosure. For vault-mounted style Vista SD units, the overcurrent control enclosure is 
fully submersible. The electronics module is removable for programming in the shop.

Programming A personal computer furnished by the user is to be used to input settings, review 
settings, and interrogate the event recorder. The software for programming the overcur­
rent control is contained within the control. Two data ports are provided—one on 
the enclosure for programming in the field and another on the electronics module for  
programming in the shop. Adapter cables are available from S&C (see Instruction Sheet 
695-515A) to connect the computer to the control.

An external power source is required for programming and interrogating the control. 
A source of dc power is available from the mouse or USB port on the personal computer. 
The adapter cables contain connectors for data and power to use the power available 
from the computer.

Description
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Power and Sensing Current transformers are provided for each three-pole fault interrupter. These current 
transformers provide primary current sensing ranging from 50 to 12,500 amperes. S&C 
Vista SD Underground Distribution Switchgear rated above 12.5 kA short circuit will 
respond to fault currents above 12.5 kA, but the event log will only record that a fault above 
12.5 kA has occurred. The overcurrent control is capable of sensing and responding to 
both phase overcurrents and ground overcurrents.

The power derived from the current transformers is used to operate the control and to 
charge the trip capacitors that discharge into magnetic latching solenoids to trip the fault 
interrupters during a fault. No external power is required for operation of the control in 
the field.

Time-Current 
Characteristics

The overcurrent control features time-current characteristic (TCC) curves consisting 
of phase-overcurrent curves and ground-overcurrent curves. The families of curves are 
included as follows:

•	 S&C standard speed curves (for use in place of conventional “E” rated power fuses

•	 S&C “K” speed curves (for use in place of conventional “K” rated power fuses)

•	 Tap fault interrupter curves

•	 Main fault interrupter curves

•	 ANSI U.S. and IEC curves per IEEE Standard C37.112-1996 U1, U2, U3, U4, U5, C1, C2, 
C3, C4, and C5

The tap and main fault-interrupter TCC curves can be customized into hundreds 
of different curves using a variety of instantaneous-pickup settings (discrete choices 
from 0.2 kA through 6 kA) and definite-time delay settings (discrete choices from  
32 ms through 128 ms). For even more specialized shapes, an instantaneous-pickup 
setting can be combined with a definite-time delay setting. The minimum total  
clearing time—from initiation of the fault to total clearing—is 40 milliseconds.▲

Settings 
(See Appendix E for a  
complete list of settings)

The overcurrent control has a phase-overcurrent pickup setting and an independent 
ground-overcurrent pickup setting for each three-pole fault interrupter.

The input parameters for both the phase- and ground-overcurrent curves include 
minimum pickup levels, instantaneous-pickup levels, and definite-time delays. 
Phase-overcurrent pickup settings and ground-overcurrent pickup settings are made  
independently. If desired, the ground-overcurrent curve and the instantaneous-
pickup and definite-time-delay attributes can be disabled. When E-speed or K-speed 
curves are selected, the ground-overcurrent pickup setting is disabled as are the  
instantaneous-pickup and definite-time-delay attributes. An example of how to select set­
tings for the overcurrent control is shown in Appendix D.

A choice of 50- or 60-hertz operation is also offered.

 
▲	 The definite-time delay setting will override the instantaneous setting when the definite-time delay setting is 
activated before the instantaneous setting.

Description
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Event Recording The overcurrent control features an internal event recorder that captures the last 
12 fault operations for each fault interrupter. The event log indicates which poles 
have experienced a fault, the magnitude of the fault, and whether a ground over­
current was involved. This information can be accessed via a personal computer  
connected to the data port of the control.

Self Testing Whenever the overcurrent control is powered up—and then periodically 
thereafter—it automatically goes through a self-test procedure to test vital sub­
systems and ensure proper operation. The control checks the trip capacitors, 
power-supply voltage, RAM, EEPROM, integrity of the data, and voltage control. It 
then flags whatever fails the self-test.

Description
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Connecting a Personal Computer

NOTICE
S&C does not recommend removing the S&C Over-
current Control from its enclosure for workbench 
programming. The Overcurrent Control is in a submers-
ible enclosure. Opening the enclosure may damage the 
sealing gasket. Contact your local S&C Sales Office for 
details.

A data port for communications is provided at the top of 
the enclosure that houses the overcurrent control. This 
data port, which is connected to the electronics module 
inside the enclosure, cannot draw power from the control 
and must be powered from an external source while in 
use. When the data port is in use, the power-connection 
points (Pins 1 and 4) power the control. The allowable 
voltage range is 4 – 5 Vdc, and the power consumption is 
1.8 W nominal, 2.2 W maximum. 

Adapter cables are available from S&C (see Instruction 
Sheet  695-515A) for  connecting  the control to  a user- furnished 
personal computer in the field. These cables provide for both  
communications and power.

For Microsoft Windows® users, no special software is 
required to communicate with the control. The user interface 
is menu driven within the control. Use the HyperTerminal  
program provided with Microsoft Windows or other 
terminal emulator program to set or interrogate the control. 
Microsoft Windows Vista™, Windows® 7, and Windows® 8 
users will have to install a terminal emulator program. See 
Appendix C for further instructions.

Setting the Communication Parameters
Set the communication parameters shown in Appendix B. 
Refer to Appendix C for additional instructions regarding 
terminal emulation programs.

Adapter cable—connect cable to personal computer, serial 
cable with PS/2 power cable shown (USB-style cable not 
shown)

Overcurrent control—(Pad-Mounted Style 
enclosure shown)

Adapter cable—connect cable to 
communications data port on enclosure

Data port

Setting Up for Programming
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Factory-Default 
Settings

The overcurrent control is provided with the factory-default settings shown here.

TCC curve type	 = E
Curve selection	 = 200E
Instantaneous pickup (amps)	 = NA
Definite-time delay (ms)	 = NA

Fault Interrupters 1 
and 2

Each overcurrent control is capable of operating up to two fault interrupters. To 
differentiate between the two fault interrupters, the programming software refers to 
Fault Interrupter 1 and Fault Interrupter 2. If the control is operating two fault inter­
rupters, the fault interrupter to the left of the control (as you are facing the front of the 
switchgear) is Fault Interrupter 1, and the fault interrupter to the right of the control is 
Fault Interrupter 2. If there is only one fault interrupter, it is Fault Interrupter 2.

Passwords Factory-Default Passwords

Type of Password
User
Group Configure

Password
6601
4731

Two passwords—the User and Group Configure Passwords—control access to the sensi­
tive areas of the menu system. The User Password must be entered to change control 
settings, test trip the solenoids, and change the User Password.

The Group Configure Password is required to change the global settings, download  
firmware, and change the Group Configure Password.

Passwords must contain four numeric characters. Each control is provided with  
factory- default passwords. The User and Group Configure Passwords can be changed, but 
the default passwords will always allow access.

Main Menu Step 1
To begin communications, open the terminal emulator program and press the Enter but­
ton (refer to Appendix C for additional instructions regarding terminal emulation). The 
control will respond with the main menu and an “=” prompt.

Step 2
Select the desired option from the Main Menu and input the corresponding number  after  
the “=” prompt. Press <ENTER>. (Option 1 is shown as an example.)

Main Menu: <select number>

1.  View Menu 1

2.  Configure Menu 1

3.  View Menu 2

4.  Configure Menu 2

5.  Change User Password

6.  Switch to Group Configure

7.  Test Trip Menu

 = 1

 INTERRUPTER 1

 INTERRUPTER 1

 INTERRUPTER 2

 INTERRUPTER 2

Programming
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Step 3
Refer to one of the following sections for further information:

Option	 Page

View Menu 1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       10

Configure Menu 1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  12

View Menu 2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       10

Configure Menu 2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  12

Change User Password . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                              14

Group Configure Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                              14

Test Trip Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     16

View Menu 1 or 2 The View Menu option allows review of the settings and status of the control. (The View 
Menu option shown below is for Fault Interrupter 1.)

Step 1
Select the desired option from the View Menu screen and enter the corresponding number 
after the “ > ” prompt. Press the Enter button. (Option 1 is shown as an example.)

Step 2
Refer to the appropriate subsection below for further information on the selected option.

Step 3
To return to the main menu, enter “9” after the “>” prompt, and press the Enter button.

View Menu INTERRUPTER 1: <select number>

1.  View event report (last 12 events)

2.  View load current

3.  View relay settings

4.  View relay self-test

9.  Switch to Main Menu

= View FI 1 > 1

View Event Report
The View Event Report option allows viewing of the last 12 recorded events for the 
selected fault interrupter. The report includes faulted poles and whether ground was 
involved, primary RMS current magnitude, and ground current for each pole at the exact 
instant fault current is detected (which values may not always make sense), and the time 
since the last event. The time is not displayed if there has been no other event since 
power up or if more than 60 seconds has elapsed since the previous report.

New events are inserted at the number 1 position. When the list is full, the oldest event 
will drop from the list. Faulted poles are indicated by an “X.”

Programming
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The overcurrent control stores a nonvolatile short event report each time it issues a trip 
pulse. The short event report contains the following information:

The faulted pole(s) and whether ground was involved. The “target” (X) logic is as  
follows:

1.	 Target any faulted poles that caused a trip.

2.	 Target any phase faulted pole with current greater than the phase time overcurrent 
pickup setting.

INTERRUPTER 1

*Eve* **Faulted Poles** * * * *  * Amperes  ** * * *
Elapsed 
**Time**

# 1 2 3 G 1 2 3 G (Seconds)

1 X X X 4 2040 1829 1908 0.019

2 X X 24 1926 18 1908

3 X X 2010 22 18 1992

Press <ENTER> for menu

NOTE:	 The “X” targets are used under fault conditions. In test mode, fault poles are ran­
domly selected.

 3.	Target the ground-faulted pole if ground current is greater than the ground pickup 
setting or if ground current is greater than or equal to 50A and greater than 10% of the 
maximum phase current.

4.	 If only one target is declared from the previous logic, target the faulted pole (of the 
remaining three with the highest current).

The primary RMS magnitude of each pole and ground current. Current greater than 
14,500 amperes will be reported as “>14500”.

The event report is reset when the fault-interrupter settings are changed and saved.

View Load Current
The View Load Current option allows viewing a snapshot of the load current sensed by 
the current transformers for each pole and ground for the selected fault interrupter.

INTERRUPTER 1

1 2 3 G

Load current (Amperes) 50 49 48 2

Press <ENTER> for menu

View Relay Settings
The View Relay Settings option allows viewing of the time-current characteristic curve 
settings, trip mode, and frequency for the selected fault interrupter.

INTERRUPTER 1

PHASE GROUND

TCC curve type E NA

Curve selection 200E NA

Inst. pickup (kA) N/A N/A

Definite-time delay (ms) N/A N/A

Trip mode

Frequency

3

60

Press <ENTER> for menu

Programming
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View Relay Self-Test
The View Relay Self-Test option allows viewing of the self-test status report for the 
selected fault interrupter. This report includes the status of the trip capacitors, supply 
voltage, RAM, integrity of the data, CR-RAM, EEPROM, and voltage control. See “Self-
Test Failures and Warnings” section on page 18 for more information.

INTERRUPTER 1

FID = S&C–1000–R100–970317

SELF TESTS

W = Warn  F = Fail

Pole # 1 2 3

Trip Caps OK OK OK

Supply + 5V + 12V

Voltage 4.99 12.26

RAM FLASH CR_RAM EEPROM V_CONTROL

OK OK OK OK OK

Press <ENTER> for menu

Configure Menu 1 or 2 The Configure Menu option allows review and changes to the TCC curve set­
tings for the selected fault interrupter. (The Configure Menu box below is for Fault  
Interrupter 1.) 

Step 1
Select the desired option from the Configure Menu screen and enter the corresponding   
number  after the “ > ” prompt. Press the Enter button. (Option 1 is shown as an example.)

Step 2
Refer to the appropriate subsection below for further information on the selected  
option.

Step 3
To return to the main menu, enter “9” after the “ > ” prompt, and press the Enter button.

Configure Menu INTERRUPTER 1: <select number>

1.  Change relay settings

2.  View relay settings

9.  Switch to main menu

= Config FI 1 > 1

Programming
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Change Relay Settings
The Change Relay Settings option allows changes to the TCC curve settings for the selected 
fault interrupter. There is a prompt for the input for each setting.

Step 1
After each prompt, enter the new setting and press the Enter button. The available choices 
are shown in parenthesis. To retain the previous selection shown after the “ = ” , press the 
Enter button.

Step 2
After all of the settings have been entered, the new settings will be displayed in a table. 
Enter “Y” for the Yes option or “N” for No option after the “Save Changes (Y/N)?” prompt. A 
confirmation of the choice will be shown and the settings will be displayed. Note that when 
new settings are saved, the event report discussed in “View Event Report” on page 10 will be 
reset.

<Press ‘Q’ to return to menu>

Phase TCC Curve (E, K, TAP, MAIN, U1, U2, U3, U4, U5, C1, C2, C3, C4, C5) = E  ?tap 

Minimum Pickup (Amps) (50, 65, 80, 100, 150, 200, 250, 300, 350, 400) = 50  ?200 

Instantaneous Pickup (kA) (OFF, 0.2, 0.3, 0.4, 0.5, 0.6, 0.7, 0.8, 0.9, 1, 2, 3, 4, 5, 6) = OFF  ?5

Definite-Time Delay (ms) @ 60Hz (OFF, 32, 48, 64, 80, 96) = OFF ?32

Ground TCC Curve (OFF, TAP, MAIN) = OFF  ?tap 

Minimum Pickup (Amps) (50, 65, 80, 100, 150, 200, 250, 300, 350, 400) = 50  ?200

Instantaneous Pickup (kA) (OFF, 0.2, 0.3, 0.4, 0.5, 0.6, 0.7, 0.8, 0.9, 1, 2, 3, 4, 5, 6) = OFF  ?1

Definite-Time Delay (ms) @60Hz (OFF, 32, 48, 64, 80, 96) = OFF  ?32

PHASE GROUND

TCC Curve Type TAP TAP

Min. Pickup (Amperes) 200 200

Inst. Pickup (kA) 5 1

Definite-Time Delay (ms) 32 32

Save Changes (Y/N)?  y

SETTINGS SAVED

PHASE GROUND

TCC Curve Type TAP TAP

Min. Pickup (Amperes) 200 200

Inst. Pickup (kA) 5 1

Definite-Time Delay (ms) 32 32

Programming
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View Relay Settings
The View Relay Settings option allows viewing of the current control settings for the 
selected fault interrupter. The trip mode and frequency settings are included.

INTERRUPTER 1
PHASE GROUND

TCC Curve Type TAP TAP

Min. Pickup (Amperes) 200 200

Inst. Pickup (kA) 5 1

Definite-Time Delay (ms) 32 32

Trip Mode

Frequency

3

60

Press <ENTER> for menu

Change User 
Password

The Change User Password option allows changing of the user password. After the new 
password has been entered, the control will return to the main menu.

Step 1
Enter the current user password after the first prompt.

Step 2
Enter the new password after the second prompt. The password must have four  
numeric characters.

Step 3
To confirm the new password, re-enter it after the third prompt.

USER PASSWORD: ? * * * * *

CHANGE USER PASSWORD

Enter new password (four digits, blank for no change) * * * * *

Re-enter new password * * * * *

Group Configure Menu The Group Configure option allows viewing and changing of the global settings, chang­
ing of the Group Configure Password, and downloading of firmware.

Step 1
Select the desired option from the Group Configure menu and enter the corresponding 
number after the “ > ” prompt. Press the Enter button. (Option 1 is shown as an example.)

Step 2
Refer to the appropriate subsection below for further information on the selected option.

Step 3
To return to the main menu, enter “9” after the “ > ” prompt and press the Enter button.

Group Configure Menu: <select number>

1.  Change global settings

2.  View global settings

3.  Change group configure password

4.  Download firmware

9.  Switch to main menu

=Group Config > 1

Programming
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Change Global Settings
The Change Global Settings option allows changing of the fault interrupter ID, trip 
mode, and frequency.

 CAUTION

Do not program three-pole fault interrupters to operate in single-pole trip mode. Single-pole 
tripping is not possible with three-pole fault interrupters.

Step 1
After each prompt, enter the new setting and press the Enter button. The available 
choices are shown in parenthesis. To retain the previous selection shown after the “ = ”, 
press the Enter button.

Step 2
After all of the settings have been entered, the new settings will be displayed in a table. 
Enter “Y” for the Yes option or “N” for the No option after the “Save Changes (Y/N)?” 
prompt. A confirmation of the choice will be shown and the settings will be displayed.

<Press ‘Q’ to return to menu>

ID for Interrupter 1 (20 characters)    = INTERRUPTER 1 

?interrupter pole 1

ID for Interrupter 2 (20 characters)    = INTERRUPTER 2 

?interrupter pole 2

1-pole or 3-pole trip mode for Interrupter 1 (1,3) = 1 ?3

1-pole or 3-pole trip mode for interrupter 2 (1, 3) = 1 ?3

50 Hz or 60 Hz Operation (50, 60) = 60 ?

ID Interrupter 1 INTERRUPTER POLE 1

ID Interrupter 2 INTERRUPTER POLE 2

Trip Mode Interrupter 1 3

Trip Mode Interrupter 2 3

Nominal Frequency  60

Save Changes (Y/N)? n

SETTINGS NOT SAVED

ID Interrupter 1 INTERRUPTER 1

ID Interrupter 2 INTERRUPTER 2

Trip Mode Interrupter 1 1

Trip Mode Interrupter 2 1

Nominal Frequency  60

2. View Global Settings
The View Global Settings option allows viewing of the global settings including the fault 
interrupter ID, trip mode, and frequency.

ID Interrupter 1 INTERRUPTER 1

ID Interrupter 2 INTERRUPTER 2

Trip Mode Interrupter 1 3

Trip Mode Interrupter 2 3

Nominal Frequency

Press <ENTER> for menu

60

Programming
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Change Group Configure Password
The Change Group Configure Password option allows changing of the Group Config­
ure Password. After the new password has been entered, the control will return to the 
Group Configure Menu.

Step 1
Enter the current Group Configure Password after the first prompt.

Step 2
Enter the new password after the second prompt. The password must have four numeric 
characters.

Step 3
To confirm the new password, re-enter it after the third prompt.

CHANGE GROUP PASSWORD

Enter new password (four digits, blank for no change) * * * *

Re-enter new password * * * *

4. Download Firmware
The Download Firmware option allows the control to be disabled for downloading and 
uploading of firmware. Refer to the nearest S&C Sales Office for instructions.

Test Trip Menu The Test Trip Menu option allows test tripping of the fault interrupters—all three poles or  
single poles.

Step 1
Select the desired option from the Test Trip menu and enter the corresponding 
number  after  the “ = ” prompt. Press the Enter button. The selected pole(s) will trip. 
(Option 1 is shown as an example.)

Step 2
To return to the main menu, enter “9” after the “ = ” prompt, and press the Enter button.

Test Trip Menu

1. Trip Mode 3 FI1 All Poles	 INTERRUPTER 1

2. Trip Mode 3 FI2 All Poles	 INTERRUPTER 2

3. Trip Mode 1 FI1 Pole 1	 INTERRUPTER 1

4. Trip Mode 1 FI1 Pole 2	 INTERRUPTER 1

5. Trip Mode 1 FI1 Pole 3	 INTERRUPTER 1

6. Trip Mode 1 FI2 Pole 1	 INTERRUPTER 2

7. Trip Mode 1 FI2 Pole 2	 INTERRUPTER 2

8. Trip Mode 1 FI2 Pole 3	 INTERRUPTER 2

9. Switch to Main Menu

= 1

Programming
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Self-Test Report

Viewing the Self-Test 
Report

The Overcurrent control tests vital subsystems upon power up and periodically there­
after to ensure proper operation. To view the self-test report, select the View Relay 
Self-Test option from the View menu for the selected fault interrupter.

INTERRUPTER 1

FID=S&C –1000 –R100 –970317

SELF TESTS

W = Warn  F = Fail

Pole # 1 2 3

Trip Caps OK OK OK

Supply + 5V + 12V

Voltage 4.99 12.26

RAM FLASH CR_RAM EEPROM V_CONTROL

OK OK OK OK OK

Press <ENTER> for menu

Response to Self-Test 
Failure

The following defines each of the self tests and the control’s response to a self-test  
failure. The control displays the above screen example when none of the self-tests have 
failed. Actual values may vary.

FID
The FID indicates the model, firmware version, and firmware date code.

Trip Caps
The status of the trip capacitors is reported for each fault-interrupter pole. If the trip 
capacitors are not charged to at least 50 volts, a “low” condition is reported. The control 
cannot issue a trip until the capacitors are fully charged. The capacitors charge from 
either the CTs or port power. If the control indicates “low” when no trip condition exists, 
the voltage supplied to the communication port is less than 4 volts or the control is defec­
tive and should be replaced.

Supply Voltage
The control periodically checks the voltage of each power supply and compares the 
results with failure thresholds. The self-test report displays the measured values.  
Protection is disabled and an “F” is placed next to the displayed value if it falls outside the 
failure threshold. This self-test also detects gross A/D converter failures.

Threshold Values

Supply Low Fail High Fail

+ 5V
+ 12V

4.5 
11.00

5.35
14.00
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Self-Test Report

RAM
The RAM self-test verifies proper operation of the read/write memory. This test periodi­
cally performs a nondestructive write/read to successive blocks of RAM to determine 
whether a RAM failure has occurred. A failure occurs if the expected data are not read 
back from the RAM. In this case, protection is disabled and “fail” is reported.

Flash
The Flash self-test verifies the integrity of the data contained in system program Flash. If 
Flash is corrupted, protection is disabled and “fail” is reported.

CR-RAM
Areas of RAM containing constant data that have been copied from EEPROM are periodi­
cally examined to verify their integrity. If this critical RAM has been corrupted, protection 
is disabled and “fail” is reported.

EEPROM
The EEPROM self-test verifies the integrity of data contained in EEPROM. EEPROM self-
test failures are handled differently because self-test failures and control settings are both 
stored in EEPROM. Following an EEPROM self-test failure, factory-default settings are 
restored and protection is enabled. The message “Relay enabled using default settings” is 
displayed at the top of each menu. If the EEPROM failure persists (i.e., if default settings 
cannot be stored in EEPROM), a self-test failure is also generated.

Voltage Control
This logic monitors the power shunt circuitry in the power supply. On power up, each 
phase magnitude is averaged for 0.5 seconds. If the average is greater than or equal to 50 
amperes and the associated trip capacitor is not charged, the CT power circuit is defec­
tive and a failure is declared.

Self-Test Failures  
and Warnings

The following screen is an example of a self-test screen. The +5-volt power supply voltage 
is flagged with an “F”, and “Relay Disabled” appears above each menu.

The control records self-test failures in EEPROM and remains disabled until power 
is removed and restored. When power is restored, the self-test is repeated. If no failure 
occurs, the failure indication changes to “warn”—or “W” in the case of a power supply—
and protection is enabled.

INTERRUPTER 1

FID=S&C–1000 –R100 –970317

SELF TESTS

W = Warn  F = Fail

Pole # 1 2 3

Trip Caps OK OK OK

Supply + 5V + 12V

Voltage 5.35F 12.12

RAM FLASH CR_RAM EEPROM V_CONTROL

OK OK OK OK OK

Press <ENTER> for menu
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Specifications

Port Power Input Voltage Range:	 4.0 to 5.0 Vdc
Input Power:	 1.8 W typical

CT Power Minimum current on any phase:
	 600-A models:	 45 A RMS

Maximum current on all phases:
	 600-A models:	 720 A continuous
		  12 kA for 1 s
		  25 kA for 0.25 s

Maximum measured current:	
	 600-A models:	 14.5 kA	

Steady State Accuracy CT:	 ±0.2% typical
Burden Board:	 ±0.3% typical
Main Board:	 ±0.2% typical

Time-Overcurrent  
Pickup Accuracy

E, K, Coordinating-Tap, and Coordinating-Main Curves:
	 −0 to +10%
	 Nominal pickup setting +5% typical

U.S. and IEC Curves:
	 ±5 A primary and ±5% of setting

Time-Overcurrent  
Response

E, K, Coordinating-Tap, and Coordinating-Main Curves:
	 −0 to +10% in terms of current OR
	 −0 to +20% in terms of time OR
	 −0 to +6 ms, whichever gives the greater allowed operating time

	 4 to 10 ms for currents greater than 2 times the current corresponding  
to a 10 ms minimum response

U.S. and IEC Curves:
±1.5 cycles and ±10% of curve time for current between 2 and 30 multiples  
of pickup, for faults not exceeding the maximum current rating

Instantaneous Pickup 
Accuracy

600-A models:	 −0 to 10%

Instantaneous  
Response

4 to 10 ms for currents greater than 2 times the instantaneous pickup setting

Definite-Time 
Response

−0 to +8 ms
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Appendix A

External Connections This section describes each of the external connections to the control. Included in  
the following tables are terminal numbers, terminal names, mating-connector  
part numbers (where applicable), and the pin-out of the data-port connectors.  
Terminal numbers are identified by labels on the electronics module or terminal block.

Trip outputs

Electronics module

Trip Outputs ①

Terminal  Number (1,2) Pole Mating-Connector Part Number

1, 2 Fault Interrupter 1, Pole 1

Phoenix 17839993, 4 Fault Interrupter 1, Pole 2

5, 6 Fault Interrupter 1, Pole 3

7, 8 Fault Interrupter 2, Pole 1

Phoenix 18761949, 10 Fault Interrupter 2, Pole 2

11, 12 Fault Interrupter 2, Pole 3

①	Trips are polarized.

20    S&C Instruction Sheet 695-515 



Appendix A

Signal inputs Power inputs

Burden-board module Burden board

Signal Inputs

Terminal  Number Signal Pole

13 Fault Interrupter 1, Pole 1

14 Fault Interrupter 1, Pole 2

15 Fault Interrupter 1, Pole 3

16 Fault Interrupter 1 Residual

17 Fault Interrupter 2, Pole 1

18 Fault Interrupter 2, Pole 2

19 Fault Interrupter 2, Pole 3

20 Fault Interrupter 2 Residual

Power Inputs

Terminal  Number Power Pole

21 Fault Interrupter 1, Pole 1

22 Fault Interrupter 1, Pole 2

23 Fault Interrupter 1, Pole 3

24 Fault Interrupter 1 Residual

25 Fault Interrupter 2, Pole 1

26 Fault Interrupter 2, Pole 2

27 Fault Interrupter 2, Pole 3

28 Fault Interrupter 2 Residual
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Appendix A

Data communications port

Electronics 
module

Communication Port Pin-Out—Electronics Module 

Pin Function

1 Power in

2 RXD (Data In)

3 TXD (Data Out)

4 No connection

5 Signal reference

6 No connection

7 No connection

8 No connection

9 Power return
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Appendix A

Data port

Overcurrent-control enclosure
(Pad-mounted style shown)

2

1

4

5

3

FACE 
VIEW

Data Port Pin-Out—Control Enclosure 

Pin Function 

1 Power return

2 RXD (Data In)

3 TXD (Data Out)

4 Power in

5 Signal reference
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Appendix B

Communication 
Parameters

NOTICE

Before using any Microsoft terminal-emulator program, disable any PDA synchronizing 
software programs. Failure to do so may cause communication problems when connecting 
to the S&C Overcurrent Control.

HyperTerminal 

Parameter Setting 

Baud Rate 9600

Parity None

Data Bits 8

Stop Bits 1

Flow Control XON/XOFF▲

▲	 The overcurrent control does not use hardware flow control (RTS, CTS).

AcSELerator Quickset SEL-5030 

Parameter Setting 

Device ★

Data Speed 9600

Data Bits 8

Stop Bits 1

Parity None

RTS/CTS OFF

DRT ON

RST ON

★	 Specify the assigned COM # from the drop down list. The assigned COM # can be found under Control Panel, 
System, Hardware, Device Manager. Expand the Ports menu. The COM # will be adjacent to “SEL to UART 
Bridge Controller.”

24    S&C Instruction Sheet 695-515 



Appendix C

NOTICE

Because of the nature of the internal connections of some secondary injection-style 
relay-test sets, a ground-loop condition can develop when both the test set and a PC are 
connected to an ac wall outlet. The ground-loop condition may damage the PC data port. 
Always isolate the PC by running it on an isolated ac supply or by running the PC on its 
battery packs.

Using Terminal  
Emulator Programs

The procedures for starting and using terminal-emulator program will vary depending 
on the specific terminal-emulator program. A simple terminal-emulator program was 
included with every copy of Microsoft Windows. 

NOTICE

Windows Vista, Windows 7, and Windows 8 do not include a terminal-emulation program. 
Users must select and install a terminal-emulator program to be able to communicate 
with the S&C Overcurrent Control. S&C recommends downloading one of two terminal-
emulator programs listed below.

Manufacturer:	 Schweitzer Engineering Laboratories, Inc.
Program:	 AcSELerator QuickSet 5030
Website:	 www.selinc.com/sel-5030.htm
Note:	 This software is available to download for free.

Manufacturer:	 Hilgraeve
Program:	 HyperTerminal
Website:	 www.hilgraeve.com/hyperterminal.html
Note:	 This software is the same software supplied with previous versions  

of Microsoft Windows. It is available for purchase.

Basic instructions for the terminal-emulator programs “HyperTerminal” (which comes 
with Windows 95, 98, 2000, NT, ME, and XP, and available for download for Windows 
Vista, 7, and 8 users) and “AcSELerator QuickSet 5030” (available for download) are 
provided on page 26.

HyperTerminal For Windows 95, 98, 2000, NT, ME, XP, Vista, 7, and 8:

Step 1
Click on the Start button.

(a)	 For Windows 95, 98, and ME select Programs and then Accessories. In the  
Accessories folder, select the HyperTerminal icon. Then double-click on  
Hypertrm.exe.

(b)	For Windows 2000, NT, and XP select Programs, then Accessories, then Commu
nications (or HyperTerminal). Then select the HyperTerminal icon.

(c)	 For Windows Vista, 7, and 8 open the HyperTerminal program from its file location  
(probably on the desktop).

Step 2
A dialog box will then ask for a “connection description.” This is a file that will be saved in 
the HyperTerminal folder with its own name and icon. It stores the appropriate settings 
for connecting to the S&C Overcurrent Control so they do not have to be entered every 
time. In the “connection description” dialog box, enter a name for this file (for example, 
“Vista”). 
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Appendix C

HyperTerminal
continuted

Step 3
The next dialog box asks for a phone number to dial. Ignore this and go to the  
Connect Using list at the bottom of the dialog box. With the relay connected, select 
the correct COM # from the drop down menu. The assigned COM # can be found  
under Control Panel>System>Hardware>Device Manager. Expand the Ports menu.  
The COM # assignment is adjacent to “SEL to UART Bridge Controller.” Click  
on the OK button.

Step 4
The next dialog box asks for the connection parameters. Enter the settings listed in 
Appendix B and click on the OK button.

Step 5
HyperTerminal should now be connected to the S&C Overcurrent Control. To  
initiate the data flow between the computer and the control, press the Enter key  
on the computer. Until the Enter key on the computer is pressed, nothing  
will be displayed on the screen. It may be necessary to click on the Disconnect button 
on the toolbar. This function is also located under the Call menu. After disconnecting, 
click on the Reconnect button on the toolbar. Again, this function is located under the 
Call menu.

Step 6
To exit this session, select File:Exit or click on the X button in the upper right- 
hand corner of the window. HyperTerminal will ask if you want to save the session  
settings. Click on Yes so that, in the future, all of the above instructions can be bypassed 
by simply clicking on the icon that you just created.

AcSELerator® 
QuickSet 5030™

For Windows Vista, 7, and 8:
Step 1

Open the AcSELerator QuickSet 5030 program from its file location (probably on the 
desktop).

Step 2
Select the Paramaters option from the Communications drop-down menu. 

Step 3
With the overcurrent control relay connected, select the correct COM # from the Device 
drop down menu. (The assigned COM # can be found under Control Panel> Sys-
tem> Hardware> Device Manager. Expand the Ports menu. The COM # assignment  
is adjacent to “SEL to UART Bridge Controller”). Then select the parameters in  
Appendix B. Click the OK button.

Step 4
To connect to the relay, select Terminal from the Tools drop-down menu. If the main 
menu does not automatically appear, press the Enter key.
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Appendix D

Coordination The S&C Overcurrent Control provides the flexibility required to meet the critical needs 
of protective device coordination between upstream and downstream devices such as 
circuit breakers and fuses. The example below shows how well the U.S. U4 time-overcur­
rent curve coordinates with both an upstream protective relay and downstream power 
fuse. The reference document used for these curve families and their equations is IEEE 
Standard C37.112-1996 IEEE Standard Inverse-Time Characteristic Equations for Over­
current Relays.

As shown in this instruction sheet and as seen on the overcurrent control’s user inter­
face, all pickup-current settings selections for E, K, Coordinating-Tap, Coordinating-Main, 
ANSI/U.S. U1 through U5, and IEC C1 through C5 are expressed in terms of primary amperes. 
However, in IEEE Standard C37.112-1996, U.S. and IEC curve families are expressed in 
terms of “multiples of pickup” where 1.0 on this axis represents the pickup setting. The 
standard uses this method of illustrating time versus current response because different 
current transformer ratios may be used for each specific application. In Vista SD switch­
gear, the CT ratio is fixed at 660:1. Consequently, we will refer to the “multiples-of-pickup” 
nomenclature for this example.

Based on the desired application, any of the 10 curve families can be selected to 
meet the coordination requirements. Adjusting the minimum pickup setting in terms 
of primary amperes moves the desired time-overcurrent curve to the left or right on 
the TCC coordination plot. In addition to the minimum pickup setting, a “time dial” 
feature is used to move the desired time-overcurrent curve up or down in time (in  
seconds) to meet the specific coordination requirements.

Example:
Referring to the coordination plot in Figure 2 on page 30, a Vista SD switchgear assembly 
with 600-ampere fault interrupters is placed into an electrical system where the upstream 
protective device is controlled by an overcurrent relay whose phase time-overcurrent curve 
family is set for a “CO-9” Very Inverse curve. The relay’s phase overcurrent pickup is set for  
960 amperes with a “time dial” setting of 2. There are two curves shown that take into 
account the operating time tolerance of the “CO-9” overcurrent relay. Downstream of the 
switchgear assembly is an S&C SMU-20 power fuse with a 200K-ampere rating. Its mini­
mum melt and total clearing curves are shown on the TCC coordination plot.

It is desired to coordinate the switchgear assembly with the upstream and downstream 
devices. A review of the ANSI/U.S. and IEC curve families resulted in the selection of the 
ANSI/U.S. “U4” curve. See Figure 3 on page 31. Its curve shape is similar to the other two 
devices’ curves. Using a TCC coordination program, it is possible to “fit” a time-overcurrent 
curve “between” the curves of the upstream source-side and downstream load-side devices. 
Note that the Vista SD curve selected is shown starting at 150% of the actual pickup setting 
in primary amperes (880 amperes × 1.5 = 1320 amperes). The Time Dial setting selection 
of 0.8 was selected to maintain an acceptable coordinating time interval (CTI) between the 
upstream protective relay phase setting, the power fuse, and the Vista SD unit. Because of 
the extremely fine resolution of pickup current and Time Dial settings selections within 
the ANSI/U.S. and IEC curve families, it is obvious there are other Pickup Current and 
Time Dial settings within the U4 family that could accomplish proper device coordina­
tion; in this example the S&C Overcurrent Control’s time-overcurrent curves are placed 
equidistant between the upstream and downstream device time-overcurrent curves.
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One final consideration in the selection of ANSI/US and IEC curve families to achieve 
proper power system coordination is the “I2t security characteristic” of the S&C Over­
current Control, included with controls having firmware version R300 or later. The 
control will self-protect its internal power supply and current-sensing circuitry when a 
Pickup setting (in amperes) and/or a Time Dial setting exceeds the thermal limits of 
the electronic circuitry (in both the electronics module and burden board assemblies). 
Figure 1 shows the “I2t security characteristic” of the S&C Overcurrent Control. When 
the “I2t security characteristic” is enabled, the control may implement a definite-time 
response characteristic of 0.25 seconds for any current magnitude above 14.5 kA. This 
matches the performance ratings of the control listed in the “Specifications” section. 
The “I2t security characteristic” does not apply to the E, K, Coordinating-Tap, and  
Coordinating-Main curve families under all settings.

S&C Overcurrent Control I2t Security Characteristic

Ti
m

e(
s)

Current (kA)

Maximum Rating

20151050 25

10

5

0

Figure 1. S&C Overcurrent Control maximum current rating adjusted for C.T. saturation.

Table 1 on page 29 should be used to determine whether the “I2t security characteris­
tic” will become enabled during the maximum calculated fault levels. In most cases, the 
Pickup Current and Time Dial settings selected will be well below the values listed in 
the table. To prevent the “I2t security characteristic” from becoming enabled, the pickup 
current and Time Dial settings must be less than the limits listed in the following table.

The operation time of the U.S. and IEC curves is a function of three variables: the 
Pickup setting, the Time Dial setting, and the fault current (measured in multiples 
of the Pickup setting). With this information, the overcurrent control calculates the 
curve operation time and the I2t security characteristic operation time, compares the 
two, and operates according to the faster time. The table provides example curve  
settings at sample fault current levels that would cause the curve operation time to  
be slower than the I2t security characteristic operation time for a 660:1 CT.

Appendix D
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Table 1. I2t Security Characteristic Settings Limits (660:1 CT) 

Curve
Affected Settings for  

Fault Current ≥ 14.5 kA 
Affected Settings for  

Fault Current = 10.0 kA

U1
Time Dials > 4.3 @ 50 A pickup 
Time Dials > 3.2 @ 1200 A pickup

Time Dials > 9.1 @ 50 A pickup 
Time Dials > 5.9 @ 1200 A pickup

U2
Time Dials > 3.9 @ 50 A pickup 
Time Dials > 3.3 @ 1200 A pickup

Time Dials > 8.3 @ 50 A pickup 
Time Dials > 5.8 @ 1200 A pickup

U3
Time Dials > 7.3 @ 50 A pickup 
Time Dials > 6.0 @ 1200 A pickup

Time Dials > 14.9 @ 450 A pickup 
Time Dials > 10.2 @ 1200 A pickup

U4
Time Dials > 14.9 @ 730 A pickup 
Time Dials > 10.0 @ 1200 A pickup

Time Dials > 14.9 @ 1100 A pickup 
Time Dials > 13.2 @ 1200 A pickup

U5
Time Dials > 14.5 @ 50 A pickup 
Time Dials > 10.6 @ 1200 A pickup

Not applicable

C1
Time Dials > 0.37 @ 50 A pickup 
Time Dials > 0.27 @ 1200 A pickup

Time Dials > 0.78 @ 50 A pickup 
Time Dials > 0.48 @ 1200 A pickup

C2
Time Dials > 0.99 @ 760 A pickup 
Time Dials > 0.61 @ 1200 A pickup

Time Dials > 0.99 @ 1040 A pickup 
Time Dials > 0.84 @ 1200 A pickup

C3 Not applicable Not applicable

C4
Time Dials > 0.17 @ 50 A pickup 
Time Dials > 0.06 @ 1200 A pickup

Time Dials > 0.37 @ 50 A pickup 
Time Dials > 0.09 @ 1200 A pickup

C5 Not applicable Not applicable

For our sample coordination study, with a U4 curve selected to have an 880- 
ampere pickup and a 0.8 Time Dial  setting, we are well below the limits shown 
for the operation of the “I2t security characteristic” during fault levels up to 14.5 
kA. The Time Dial setting is below the threshold of 10.0 at a Pickup setting of  
1200 amperes.

If the setting was above the limit for the “I2t security characteristic,” a warning message 
would be displayed with the calculation of the cross over point in primary amperes of the 
selected US or IEC curve with the “I2t security characteristic” curve. A sample warning 
message is shown below.

“Phase overcurrent control will operate on the TOC curve for faults up to 18476 A. 
Phase overcurrent control will operate on its maximum I2t (thermal) limit curve for 
faults above 18476 A. Refer to S&C Instruction Sheet 681-515 Appendix D.”

When this occurs, the user must consider the following:

If the fault level displayed in the warning message is higher than the maximum 
available fault current level at the switchgear assembly, the “I2t security character­
istic” will not become enabled. If the fault level displayed in the warning message is 
lower than the maximum available fault current level, then the “I2t security character­
istic” will become enabled resulting in a faster time to operate. To prevent this from 
occurring, new settings selections should be considered to prevent miscoordination 
between upstream source-side and downstream load-side devices. Contact S&C Electric  
Company—Power Systems Solutions for application assistance.
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Current in Amperes: x 10 at 12.47 kV.
1000

100

10

1
51

sdnoceS ni e
miT

Phase
Relay

600: 5

S&C Overcurrent Control 
Curve: U.S. U4
Pick Up: 880.00 [A] TD: 0.800

0.1

51 Vista

200K fuse

0.01
0.4 1 10 1000100 10000

Fuse
S&C SMU20 K 14.4kV
Rating: 200.0 [A]
12.47[kV]

Phase Relay
Relay WEST CO-9
Tap Range: [-] Tap: 0
Pick Up: 960.00 [A] TD: 2
CT: 600:5 at 12.47 [kV]

Figure 2. An S&C Overcurrent Control programmed with ANSI/U.S. U4 curve.
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Appendix D

Current, Multiples of Pickup
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Figure 3. A U.S. Extremely Inverse U4 Curve.
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Overcurrent Control 
Settings

The S&C Overcurrent Control can be programmed to provide a wide variety of settings 
combinations. Listed below are the setting ranges that are displayed when the control is 
connected to a personal computer.

For C.T. Ratio of 660:1:

Phase TCC Curve (E, K, TAP, MAIN, U1, U2, U3, U4, U5, C1, C2, C3, C4, C5)

For E-Speed Curves: 
Curve Selection (25E, 30E, 40E, 50E, 65E, 80E, 100E, 125E, 150E, 175E, 200E, 250E,  
300E, 400E)

For K-Speed Curves: 
Curve Selection (25K, 30K, 40K, 50K, 65K, 80K, 100K, 125K, 150K, 175K, 200K)

For Coordinating-Tap Curves: 
Minimum Pickup (Amperes) (50, 65, 80, 100, 150, 200, 250, 300, 350, 400)

For Coordinating-Main Curves: 
Minimum Pickup (Amperes) (100, 150, 200, 250, 300, 350, 400, 450, 500, 600, 700, 800)

For Curves U1-U5 and C1-C5: 
Minimum Pickup (Amperes) (50-1200, 1 A steps) 
Time-Dial Multiplier U Curves (0.5 – 15.0, 0.1 steps) 
Time-Dial Multiplier C Curves (0.05 – 1.0, 0.01 steps)

For Coordinating-Tap and Coordinating-Main Curves: 
Instantaneous Pickup (kA) (OFF, 0.2, 0.3, 0.4, 0.5, 0.6, 0.7, 0.8, 0.9, 1, 2, 3, 4, 5, 6)

For Curves U1-U5 and C1-C5: 
Instantaneous Pickup (Amperes) (OFF, 200 – 13200, 20 A steps)

For Coordinating-Tap and U1-U5 and C1-C5 Curves: 
Definite Time Delay (ms) @ 60 Hz (OFF, 32, 48, 64, 80, 96) 
Definite Time Delay (ms) @ 50 Hz (OFF, 40, 60, 80, 100, 120)

For Coordinating-Main Curves: 
Definite Time Delay (ms) @ 60 Hz (OFF, 64, 80, 96, 112, 128) 
Definite Time Delay (ms) @ 50 Hz (OFF, 80, 100, 120, 140, 160)
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Appendix E

Ground TCC Curve (OFF, TAP, MAIN) or (OFF, U1, U2, U3, U4, U5, C1, C2, C3, C4, C5 
See Notes 1 and 2

For Coordinating-Tap Curves: 
Minimum Pickup (Amperes) (50, 65, 80, 100, 150, 200, 250, 300, 350, 400)

For Coordinating-Main Curves: 
Minimum Pickup (Amperes) (100, 150, 200, 250, 300, 350, 400)

For Curves U1-U5 and C1-C5: 
Minimum Pickup (Amperes) (50 – 400, 1 A steps) 
Time-Dial Multiplier U Curves (0.5 – 15.0, 0.1 steps) 
Time-Dial Multiplier C Curves (0.05 – 1.0, 0.01 steps)

For Coordinating-Tap and Coordinating-Main Curves: 
Instantaneous Pickup (kA) (OFF, 0.2, 0.3, 0.4, 0.5, 0.6, 0.7, 0.8, 0.9, 1, 2, 3, 4, 5, 6)

For Curves U1-U5 and C1-C5: 
Instantaneous Pickup (Amperes) (OFF, 200 – 13200, 20 A steps)

For Coordinating-Tap and U1-U5 and C1-C5 Curves: 
Definite Time Delay (ms) @ 60 Hz (OFF, 32, 48, 64, 80, 96) 
Definite Time Delay (ms) @ 50 Hz (OFF, 40, 60, 80, 100, 120)

For Coordinating-Main Curves: 
Definite Time Delay (ms) @ 60 Hz (OFF, 64, 80, 96, 112, 128) 
Definite Time Delay (ms) @ 50 Hz (OFF, 80, 100, 120, 140, 160)

Note 1: Ground settings are not displayed and are disabled if the Trip mode is set for 
the 1-Pole Trip setting or if the Phase TCC curve selected is either E-speed or K-speed.

Note 2: Ground curves can be selected to provide a different TCC curve than the phase 
setting. However, when TAP or MAIN is used for the phase TCC, only MAIN and TAP TCC 
curves can be selected for the ground TCC setting. When a U or C curve is selected for the 
Phase TCC, only the U and C families can be selected for the ground TCC setting.
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